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PC World Multimedia Edition LIVE! Help is designed to give you the information you need to 
make your PC World Multimedia Edition LIVE! experience most enjoyable.    From getting 
started to troubleshooting guidelines, you'll find the help you need here.
 
Click the subject of your choice below (green, underlined words only):
 
Introduction to PC World Multimedia Edition LIVE! 
What's New?
Installation
Start 
Magazine Contents
Explore a Story
Navigating the Magazine 
Customer Service & Technical Support 
Troubleshooting 
 
 
Navigating through this Help file.      Above you will find a menu bar containing Contents, 
Search, Back, and arrow Browse buttons.    The Contents button will return you to this Help File 
Contents page.    You can use the Back button to return to the page you just previously viewed. 
The arrow buttons will navigate you through a Browse sequence that somewhat follows the Help 
File Contents list but in more detail.    You can use the Search button to find a specific word or 
topic within the help file.
 

 Distributed throughout the text are green, underlined words which you can click to access 
related topics, such as those listed above.



Introduction
 
PC World Multimedia Edition LIVE! is the multimedia magazine for the rest of your brain.    More 
than just visual stimulation, it provides auditory, kinesthetic, and aesthetic enjoyment, too.
 
The CD-ROM magazine has the familiar appearance of a print publication, but it presents 
content -- both general interest and computer-related stories -- in dynamic, multimedia articles 
incorporating narrative, sound, images, applications, movies and more.    The multimedia 
articles, along with additional software and information, are arranged into several major content 
departments:    "UpFront," "Resources," "Titles," "Reviews," and "Advertisers." 
 
PC World Multimedia Edition LIVE! debuted in July 1995 as Multimedia World LIVE!      
Beginning with the September 1996 edition, the magazine was able to increase the amount of 
content it provides along with the improved CD-ROM interface due to the merging of Multimedia 
World magazine with PC World magazine.    Since its inception, however, each CD-ROM 
publication has continued to deliver approximately 500 megabytes of new information and 
resources to you every month.
 
All comments, questions, editorial submissions or business inquiries should be directed to:
 
PC World Communications
501 Second St.
San Francisco, CA 94107
415/281-8650
Fax 415/281-3915
 
-or-
 
PC World Multimedia Edition LIVE!
Metatec Corporation
7001 Metatec Boulevard
Dublin, OH    43017
614/761-2000 
 
Or via the Internet at:    mmwlive@pcworld.com    or    editorial@mmwlive.metatec.com.
 
 
Copyright
 
PC World Multimedia Edition LIVE! is a servicemark of PC World Communications, Inc. 
Copyright© 1996. 
 
ToolBook(R) is a registered trademark of Asymetrix Corporation; Microsoft(R), Windows(TM), 
and Video for Windows(TM) are registered trademarks of Microsoft Corporation; QuickTime for 
Windows (TM) is a trademark of Apple Corporation. IBM(R) is a registered trademark of 
International Business Machines Corporation; MPC(CM) is a certification mark of the Multimedia 
PC Marketing Council; all other products are copyright of their respective owners.

Return to Help File Contents page



What's New?

Beginning with the September 1996 edition, Multimedia World LIVE! changed to PC World 
Multimedia Edition LIVE!        It did so due to the merging of Multimedia World magazine with PC 
World magazine and is now able to increase the amount of content it provides you. 

Web Browsing:    If you already have America Online, CompuServe Mosaic, Internet Explorer or 
Netscape Navigator software installed on your computer, you can go directly to a designated 
Web page from this disc!    It's easy -- simply select the associated Web buttons placed 
throughout this disc.    First, though, you must set up a specific Web Browser by using the 
Options menu item.

In July, just prior to the change in its title, the CD-ROM publication underwent the following 
improvements to its interface:

NEW    Navigation
 
The July 1996 issue    of Multimedia World LIVE! (MMW) magazine was the first in the 
PCW/MMW version 2.0 series that used a navigational metaphor similar to a notebook tabbing 
system.    It was streamlined to give you quicker access to the articles:    The department pages 
were replaced with a listbox of each department's articles which is available on every page.    
Other features and options were improved for you as well.
 
NEW    ToolBook Version

Both the PC World Multimedia Edition LIVE! Version 2 and MMW Version 2 use Multimedia 
ToolBook 4.0 instead of the 3.0 version used on previous Multimedia World LIVE! discs.    If you 
have older MMW discs (1.0 versions) that you want to view, you will need to keep the ToolBook 
3.0 applications and extensions in your system or reinstall the old MMW disc before running it 
again.    When MMW 1.0 discs were installed onto your hard drive, files were placed in a folder 
entitled MMWLIVE.    During installation of this 2.0 disc, files were placed on your hard drive in 
the MMWLIVE2 folder.
 
NEW    Uninstall

In addition, both the PC World Multimedia Edition LIVE! Version 2 and MMW Version 2 have an 
Uninstall application available to you should you want to remove files placed on you hard drive 
by the MMW 2.0 installation.    Uninstall will delete initilization (.ini) files, the startup program 
group, and all components of the MMWLIVE2 folder.    It will not, however, uninstall any files for 
ToolBook 3.0, QuickTime, Video for Windows, or files you created yourself.    See the Uninstall 
section of Installation for more information.    NOTE:    It is not necessary to uninstall 2.0 files to 
be able to run past or future PCW/MMW discs -- this is simply a feature added for your 
convenience.
 
NEW    Way to View

Lastly, it is now possible to view PCW/MMW 2.0 discs without installing the magazine's runtime 
files.    However you will still need to have Video for Windows and QuickTime for Windows 

installed to play movies.    See Startup for more information.



Installation
 
Getting Started
 
Install runtime components of the PC World Multimedia Edition LIVE!  disc onto your hard drive 
using the Setup.exe application.    (See your system's Help file if you have questions about 
installing a CD-ROM disc.)      You can begin installing the disc a number of ways, including 
these:
 

· Double-click the Setup.exe application on the disc in the CD-ROM drive (usually the D 
drive); or

· In Windows 95, open Start on the taskbar, select Run, and type in D:\Setup.exe (which is 
the CD-ROM drive letter, colon, backslash, and the installation application named 
Setup.exe); or 

· In Windows 3.1, from the Program Manager open the File menu, select Run, and type in 
D:\Setup.exe (which is the CD-ROM drive letter, colon, backslash, and the installation 
application named Setup.exe).

 
Then follow the instructions that appear on your screen.
  
Setup
 
Setup allows you to install the PC World Multimedia Edition LIVE! runtime files, which provide 
complete access to the PC World Multimedia Edition LIVE! magazine.    PC World Multimedia 
Edition LIVE!    requires about 3MB available on your hard disk for installing the PC World 
Multimedia Edition LIVE! Startup, Multimedia ToolBook runtime, and other necessary files.    It 
requires more if your system also needs Video for Windows or QuickTime for Windows installed, 
but Setup will inform you of these requirments and your system's available space.
  
Microsoft Video for Windows and Apple QuickTime for Windows runtime software provide 
everything you need to be able to play digital videos from within the PC World Multimedia 
Edition LIVE! magazine or Media Player.    Setup determines for you if it is necessary to install 
either option, both of which are available from within the PC World Multimedia Edition LIVE! 
Setup folder.    For instance, you may not need to install VfW (Video for Windows) if you have 
already done so (from a previous disc, for example).    However, if there is an updated driver for 
Video for Windows, PC World Multimedia Edition LIVE! Setup will run the VfW Setup program 
for you.

If you do not want Setup to perform the typical type of installation, you also have the option to 
select Custom Setup which calls up the following dialog box.    To select or deselect an option, 
double-click the appropriate check box.    Select the Next button at the bottom of the screen to 
continue and finish the setup procedure. 



 

Uninstall

PC World Multimedia Edition LIVE! 2.0 versions have an Uninstall application available to you 
should you want to remove files placed on you hard drive during installation.    Uninstall will 
delete initilization (.ini) files, the startup program group, and all components of the MMWLIVE2 
folder.    It will not, however, uninstall any files for ToolBook 3.0, QuickTime, Video for Windows, 
or files you created yourself. 

You must have the disc in the CD-ROM drive to uninstall it.    You can then access it through the 
PC World Multimedia Edition LIVE! program in the Start menu of your taskbar (Windows 95) or 
in Program Manager (Windows 3.1).    You can also directly access the file, UNINSTAL.EXE, 
which is contained within the SETUP folder of the disc. 

NOTE:    It is not necessary to uninstall 2.0 files to be able to run past or future PCW/MMW discs 
-- this is simply a feature added for your convenience.

Running Without Installation

It is possible to run this disc without installing the magazine's runtime files.    However you will 
still need to have Video for Windows and QuickTime for Windows installed to play movies.    See 

Startup for more information.



System Requirements
 
A multimedia PC or equivalent PC is required to operate this CD-ROM.      You may need to 
readjust your display's color setting to view graphics at their best.
 
The following chart details the recommended system specifications for optimal operation of the 
PC World Multimedia Edition LIVE! disc:
 

--    486 / 33 or higher processor
--    640x480 display with thousands of colors (16-bit)
--    8MB RAM
--    Double Speed CD-ROM Drive
-- 16-bit Sound Card with speakers or headphones
--    Microsoft Windows 3.1 or later
--    MS DOS 5.0 or later

 



Display Color Setting
 
Graphics and movies on this disc will look their best if your display (monitor) is set to thousands 
of colors.    The standard default setting on many computers is often 256 colors or less; 
however, on a multimedia PC you should be able to increase that setting.    Optimally, you want 
to select a high color, 16-bit or greater, 32K or greater color palette.
 
Windows 95.      Consult your system's Help file for direct access to the Display 
Properties\Settings dialog box which is contained in your Control Panel.    (In the Help\Find 
dialog box, typing the words display, monitor, screen, or color will call up the topic 'changing the 
number of colors your monitor displays.')    Change the color setting by clicking the arrow to the 
right of the color palette field and selecting the appropriate bit-depth available in the drop-down 
box.
 

 
 

Windows 3.1.      Because configuration differs for various systems, please consult your owner's 
manual and/or contact your video card manufacturer about changing your system settings.



Video for Windows

Video for Windows (VfW) is the video technology developed by Microsoft Corporation and used 
for the playback of movies found on this disc.    Video for Windows version 1.1e (or later) must 
be installed on your system for movies to be played.    The PC World Multimedia Edition LIVE! 
Setup application checks for Video 1.1e on your system, and, if it determines your system does 
not have VfW or has an older version, it prompts the VfW installer to run. 
 
If needed, VfW was placed on your hard drive using the installer executable located in the 
Setup\VfW directory of this disc.    Several Control Panel drivers were automatically added to 
your Windows\System directory, and an updated Media Player, MPLAYER.EXE, was installed to 
your Windows directory.
 
Note:    If you have Windows 95, the Video for Windows 1.1e installer will not need to be run 
because a higher, 16-bit version of Video for Windows was included with Windows 95.

Manual Installation

If you chose to run this disc without using Setup.exe to install the magazine runtime files onto 
your hard drive, you will still need to have Video for Windows installed on your system to play 
movies.    Go to the disc's SETUP\VFW directory and double-click VFWSETUP.EXE to install it 

manually.



QuickTime for Windows
 
QuickTime (QT) for Windows is the video technology developed by Apple Computer, Inc. and 
used for the playback of movies found on this disc.    QuickTime version 2.1.1 (or later) must be 
installed on your system for movies to be played. 
 
The PC World Multimedia Edition LIVE! Setup application checks for QuickTime 2.1.1 on your 
system, and, if it determines your system does not have QT or has an older version, it prompts 
the QT installer to run.    This installer first checks your system for older versions of QuickTime 
and prompts you for permission to delete them.    Apple recommends that their installer be 
allowed to delete older versions, since they can conflict with version 2.1.1.      (NOTE:    Previous 
issues of this CD-ROM publication provided QuickTime 2.03.    It is recommended that you allow 
Setup to update your system.)
 
If needed, QT was placed on your hard drive using the installer executable located in the 
Setup\QTW directory of this disc.    Several MCI drivers, DLLs, and QTC files were automatically 
added to your Windows\System directory, and updated Movie Player, PLAYER.EXE, Picture 
Viewer VIEWER.EXE, and Help files were installed to your Windows directory.    A Quick Time 
group icon was created in your Windows Program Manager or Windows 95 Start\Program 
menu.    For more information, read the QT README.EXE file found within the QT group or in 
your Windows directory.

Manual Installation
 

 If you chose to run this disc without using Setup.exe to install the magazine runtime files onto 
your hard drive, you will still need to have QuickTime for Windows installed on your system to 

play movies.    Go to the disc's SETUP\QTW directory and double-click QTINSTAL.EXE to install 
it manually.



Multimedia ToolBook
 
PC World Multimedia Edition LIVE! 2.0 versions    use Multimedia ToolBook 4.0 instead of the 
3.0 version used on Multimedia World LIVE! issues made prior to July 1996.    All the Multimedia 
ToolBook runtime versions necessary to run PC World Multimedia Edition LIVE! version 2.0 are 
located in the MTB40 subdirectory of this disc's Setup directory. 

During installation of this 2.0 disc, files were placed on your hard drive in the MMWLIVE2 folder. 
All the MTB 4.0 and TB 4.0 executable (.exe) and dynamic link library (.dll) files that are 
contained in the Setup\MTB40 subdirectory were created by Asymetrix Corporation.    Two other 
files installed into the MMWLIVE2 folder are METAPLAY.EXE and MPT.DLL, both of which were 
created by Metatec Corporation.

If you have older MMW discs (1.0 versions) that you want to view, you will need to keep the 
ToolBook 3.0 applications and extensions in your system or reinstall the old MMW disc before 

running it again.    When MMW 1.0 discs were installed onto your hard drive, files were placed in 
a folder entitled MMWLIVE.



Startup
 
Running PC World Multimedia Edition LIVE! :
 

1) Be sure the disc is in the CD-ROM drive.

2) Once you have installed the CD-ROM (using Setup.exe), you can open the application a 
number of ways:
a) In Windows 3.1, open the PC World Multimedia Edition LIVE! Version 2 program in 

Program Manager.    Double-click on its internal PC World Multimedia Edition LIVE! 
Startup icon.

b) In Windows 95, open the PC World Multimedia Edition LIVE! Version 2 program in 
the Start menu of your taskbar.    Select its PC World Multimedia Edition LIVE! 
Startup submenu item.

c) In either, run Metaplay.exe from the MMWLIVE2 folder in File Manager or Windows 
Explorer.

 
3) The Metaplay startup application will open to the magazine cover.    Using its menu bar, 

you are able to view this help file, choose media viewing options, navigate to the PC 
World Multimedia Edition LIVE!  articles, and access some additional features.    In the 
main text screen, you'll find an In This Issue button to access a video overview of the 
disc. 

 
4) To progress through the PC World Multimedia Edition LIVE!    articles, select either a) the 

Table of Contents button, b)    the Next Page item in the Navigate menu, or c) the forward 
arrow on your keyboard.    From the next page--the Table of Contents--you can select 
any of the five departments of PC World Multimedia Edition LIVE! magazine.

 
Running without installing the disc onto your hard drive:

You can view this disc without installing the magazine's runtime files; however, be aware that 
you may experience a loss in performance.    To view the disc in this manner, simply double-click 
the CdRun.exe file in the root (beginning) of the disc's directory.    Then press the Run button 
option in the Run...from CD-ROM Drive dialog box (below).

 



Remember, you will still need to have Video for Windows and QuickTime for Windows installed 
to play movies.    These can be installed manually if you do not have them or have an older 

version than is required by this disc.



Options
 
The Options item, found in the Tool menu, allows you to set your own standards for using the 
PC World Multimedia Edition LIVE! magazine.    This is where you will select the appropriate 
letter of your CD-ROM drive and decide whether "auto" media plays only once per viewing 
session or every time you return to a page.
 
Options also lets you control the displaying of media extensions (opening files in the PC World 
Multimedia Edition LIVE! magazine) by the default pop-up viewer or by your own custom 
application (a particular application you already own).    For example, you may want to open 
a .WAV file with Media Player instead of the pop-up viewer feature of PC World Multimedia 
Edition LIVE!     All you need to do is select the Use Other Viewer/Player... radio button for the 
media extension you wish to open with your own applications.    This calls up a dialog box to 
help you select an application to play such files.    Locate the application on your hard drive and 
click OK.    Now, every time you launch that media extension in the PC World Multimedia Edition 
LIVE! magazine, it will open with your favorite application. 
 
Web Browsing:    You now have the choice to set up a Web Browser, or even none, if your 
computer has one or more browsers that are compatible with this disc.      Simple click on an 
option from the list of available browsers (e.g., America Online, CompuServe Mosaic, Internet 
Explorer or Netscape Navigator), then select the Apply button.    Once a browser is selected, this 
will be how your Web button accesses a Web page.
 

 



Magazine Contents
 
The PC World Multimedia Edition LIVE! magazine is a monthly compilation of material in regular 
departments and sections, items of common appeal or interest grouped together and presented 
with multimedia layers so that you can do more than read about a topic; you’re compelled to 
experience it, play with it, put it to use. 

Table of Contents, 5 departments:
 

1) "UpFront" contains all the resources for new users, potential users, and long-term users 
to learn more about PC World Multimedia Edition LIVE! in the sections For New Users, 
Subscribe, and Editorial Letters.    In addition, the "UpFront" department gives you the 
Table of Contents page and the Feature article(s) of the month. 

 

 

NOTE:    Clicking on the graphic below the title 'What's New this Month' will navigate you 
directly to the beginning of the feature article.    Clicking on any department button along 
the right of the main text screen will take you to the first article of that department.    
Especially 'For New Users' is a green button in the top right corner;    this button will 
invoke the navigational help movie.    All these hotspots will change colors when the 
mouse passes over them.

2) "Resources" focuses on increasing your personal productivity by showing you How To 
use your    multimedia PC more effectively and troubleshoot problems about which users 



have sought our advice.    As a supplement to the print magazine, it also offers selected 
Shareware applications, tools, utilities; a media bank full of clip art, fonts, sounds, and 
more; as well as entertaining games and diversions.

 
3) "Titles" will keep you up to date on the latest multimedia CD-ROM titles and industry 

advances, take a First Look at upcoming and newly released products, and give you a 
Behind the Scenes report on the multimedia industry.    The software Reviews section is 
designed to supplement the print magazine.

 
4) "Reviews" plugs you into information about hardware and additional software 

applications. 

5) "Advertisers" gives you quick access to a listing of all the advertisements interspersed 
amongst the articles.

 



Navigation
 
The PC World Multimedia Edition LIVE! magazine has a simple architecture similar to that found 
in a typical print magazine.    Listed on the tabs down the left margin of the screen are the major 
content departments:    "UpFront," "Resources," "Titles," "Reviews," and "Advertisers."    Within 
each department are a variety of articles that display in the main text screen on the right.    
Livening up the articles are the media files linked to icons on many article pages.

 
There are a number of ways to navigate the PC World Multimedia Edition LIVE! magazine:
 
Department Tabs
Page by Page 
Menu Bar
Article List

History List



Media Icons
 
Explore a Story with Media Extensions:    Pages in the PC World Multimedia Edition LIVE! 
magazine may look like their print counterparts, but "underneath" there’s a dynamic, multi-
dimensional layer waiting to be explored.    Bring that story alive by clicking any media extension 
icon -- play a movie, hear the artist, read more details, fill your screen with an image or access 
related files and applications right on the disc.
 
These icons that add the multimedia layer are called media extensions:
 

     Play a video or animation component of the story.
 

     Expand an image to its fullest dimension.
 

     Reveal the text narrative that accompanies an article.
 

     Play digitized sound clips (WAV files) or CD audio tracks.
 

     Directly launch an application (shareware, games, demos, etc.).
 

    Access a multitude of applications.

    Connect to a designated World Wide Web page.*

The source files for every icon presented in the magazine can be explored directly from the disc 
as well.    Text (.txt and .doc), graphics (.bmp) sound (.wav), movies (.avi and .mov) and more 
can be accessed from folders named for the departments (UpFront, Resources, Titles, Reviews, 
and Ad_index) and sections to which they are linked.

* World Wide Web Access:

PC World    has a page on the World Wide Web for you to view.    Its Uniform Resource Locator 
(URL) is http://www.pcworld.com.    Other companies which provided content for this CD-ROM 
also have Web pages to which you can navigate directly from this disc.

If you already have America Online, CompuServe Mosaic, Internet Explorer or Netscape 
Navigator software installed on your computer, you can go directly to a designated Web page 
from this disc!    It's easy -- simply select the associated Web buttons placed throughout this 
disc.



You have the choice to set up a Web Browser, or even none, if your computer has one or more 
browsers that are compatible with this disc.      Use the Web Browser option in Options to 
change your selection at any time.    Simple click on an option from the list of available browsers, 
then select the Apply button.

Before you can launch a Web page --

CompuServe Users:      Be sure your current CompuServe session settings are using Winsock.

Internet Explorer and Netscape Navigator Users:      If you get an error message saying your 
browser was unable to locate the server or create a connection, you may need to establish a 

connection (dial) first.



Page by Page
 
One of the simplest navigation techniques is to move sequentially through the magazine:    that 
is, page by page.    At the bottom of every page you’ll find a pair of useful buttons.    At the far 
right and left sides of the main text screen are arrow buttons.    Clicking an arrow button moves 
you forward or backward through the magazine one page at a time.    The Right and Left arrow 
keys on your keyboard function in the same way. 
 

 
 
TIPS:    1)    For quickly browsing the magazine, you can hold these green arrows down to flip 
through the pages.
                          2)    To access a specific page, you can click on the page status (e.g., Page 4 of 
42).    The type and background will reverse colors when the mouse passes over this area.



 
 

This dialog box will appear when you click on the page status at the bottom right of the main text 
screen or you select the Go To... item under the Navigate menu.    Type in the page you want 

view, then click OK.



Department Tabs
 
Tabs for the main content departments are presented down the left side of the display.    When a 
new tab is selected, the first article page of that department automatically displays.    Tabs can 
be selected with either a single click of the mouse or by using the Tab key on your keyboard.
 
Clicking on a department tab also displays a listbox of article titles immediately to the right of the 
tab.    The full title of a partially displayed article title (ending in ellipses) will appear whenever 
the mouse rolls over it.    Clicking on the title will directly navigate you to the beginning of that 
article.
 
Up and Down arrows at the bottom of the article list will appear only if the list is longer than the 
listbox.    The Up and Down arrow keys on your keyboard function in the same way. 
 

  



Menu Bar
 
The Menu Bar contains special functions from additional navigational tools to Internet 
connectivity for enhancing your PC World Multimedia Edition LIVE! experience.  AND if you're 
not yet a subscriber or you have friends you'd like to share this experience with, you can open 
the Subscribe menu's How to Subscribe item to quickly print a subscription form.
 

 
 
Navigational Tools
 
Not only does the Menu Bar allow you to navigate to the next and previous pages of this 
magazine, but it gives you the ability to see a list of the articles you recently viewed and 
navigate backward through your progression.    The History item displays the articles you have 
viewed in this session.    The Back item lets you retrace every step of your progression.    In 
addition, the Article List item displays the entire contents of the magazine, and the Go To... item 
allows you to select a particular page to view.    All of these functions are listed under the 
Navigate menu.  NOTE:    Although the Web Site item is greyed out in this issue, it will be 
available and explained in future publications.
 
Additional Tools
 
Listed under the Tools menu are the Find and Options items.    Find allows you to search for a 
specific word within the text of the magazine.    Options gives you the ability to control your 
media viewing experience.

Help

Two types of help files are available in the Help menu.    For the fast-action, visual learner, a 
navigational movie is available from the Using this CD item.    This detailed, textual help file is 
available from the Help Topics item.
 
Exit
 
Exit can be found under the File menu.
 

 



Article List
 
The Article List item under the Navigate menu gives you the most detailed listing of the 
magazine's contents.    Similar to an outline, the titles are listed hierarchically: aligned to the left 
are department titles, followed by section titles, then article titles.    After you select a title, click 
on the Go To button.
 

  
 

 



History List
 
The History item under the Navigate menu allows you to return to recently visited topics in the 
magazine.    As you leave a section, its title and/or page number will be added to the History list. 
You can then go back to that section by opening the History item, selecting the section you wish 
to return to, and clicking OK.
 

 
 



 
 

To search for a specific word within the text of the magazine, first select the Find item under the 
Tools menu.    Then type in the word you    want to find, and click the Search button.



Customer Service & Tech Support
 
Questions?    Refer to the READ_1ST.TXT file on the disc for full details, the Troubleshooting 
section later in this Help File, or contact PC World Multimedia Edition LIVE! Support Services:
 

 
· To Subscribe or Renew Your Subscription:
 

Domestic: 800/766-3294
 
 
· For Customer Service, Billing Inquiries or Problems with your Subscription:
 

Domestic: 800/766-3294
 
 
· For Technical Support:
 

Call 614/791-3747, 8:30 a.m. until 5:30 p.m. (Eastern), Monday through Friday. 
 

When calling for technical support, please be sure to provide information about your 
system (model, CPU and clock speed, RAM, DOS version, Windows version, CD ROM 
drive and driver version, video card and drivers, sound card and drivers), plus a 
description of exactly what you were trying to do and what happened.

 
· You can request technical support via the Internet at the following address:

techsupport@mmwlive.metatec.com
 

Please send us your name, address, telephone number, any online addresses, and the 
nature of your question or problem.    Please also provide the Volume number of the disc.



PC World Multimedia Edition LIVE! 

TROUBLESHOOTING

Audio for .AVI (movie) files 
CD Audio 
DOS Demos
General Protection Faults 
Memory errors 
Msvideo.dll Errors
Multitasking with CD Audio 
Network Problems 
OS/2 or Windows NT 
Stack Fault Errors 
Static Sound Card 
Text and Graphics 
Undefined Dynalink Errors 
Vendor Contact Numbers 
VfW Driver 
Video Playback / Synchronization 
Vids: Cvid Decompressor Errors
 Windows 95 Installation
 
 
PC World Multimedia Edition LIVE! Technical Support representatives are available Monday 
through Friday from 8:30 a.m. until 5:30 p.m. EST. 
 

Voice: 614/791-3747
Fax: 614/761-4110
Internet:      techsupport@mmwlive.metatec.com

 
When contacting us online, please include your complete name, address, and telephone 
number in addition to your online address.
 

 



Troubleshooting

Inability to Hear Audio When Playing an .AVI (Video for Windows) File
 
Summary:
The videos in the magazine play and can be viewed, but no audio can be heard.
 
Information:
This usually happens when you have older 16-bit sound card drivers installed on your system.    
To check and see if this is the case, put a PC World Multimedia Edition LIVE! disc into the CD-
ROM drive.    Then, open Windows File Manager or Windows Explorer, locate the CD-ROM 
drive icon and double-click on it.    Locate an .AVI file and again, double-click on it.    The file 
should come up and play directly from Windows File Manager or Explorer, and you should be 
able to view it and hear the audio.
 
If you can hear the audio on the .AVI file when playing it directly from Windows File Manager or 
Explorer but you can’t hear it from the magazine, then there is a conflict between Multimedia 
ToolBook (what we use for the front end of our magazine) and certain (older) versions of 16-bit 
sound card drivers.    The usual solution in this case is to upgrade the sound card drivers to the 
latest ones available.    Check with the manufacturer of your sound card for driver software 
updates.



Troubleshooting
 
Problems Playing CD Audio
 
Summary:
The following information should assist you in playing the CD Audio tracks / Redbook files on 
the PC World Multimedia Edition LIVE! discs.
 
Information:
To play the CD Audio Tracks from within the PC World Multimedia Edition LIVE! magazine, you 
need to make sure you have installed the MCI CD Audio driver (MCICDA.DRV) from your 
Windows diskettes.    You can use the drivers applet in the Control Panel to install it.    Please 
refer to the Windows readme files for further details.
 
Also, be sure you have speakers hooked up to your CD-ROM drive.
 

Note:    If you are using DOS 6.0, be sure to have a PC World Multimedia Edition LIVE! disc or 
CD Audio disc in your CD-ROM drive when you install the MCI CD Audio driver.



Troubleshooting
 
DOS Demos
 
Summary:
Many DOS demos will not run properly in Windows or may run on some machines and not 
others.
 
Information:
DOS demos that do not run or run improperly are usually the result of memory constraints.    
Although we carefully test all content on the disc, it is not possible to do so with every hardware 
and software configuration.    Therefore, if you encounter difficulties, try running the demo 
directly from DOS.
 



Troubleshooting

General Protection Faults with PC World Multimedia Edition LIVE!
 
Summary:
Receiving General Protection Faults (GPFs) when attempting to view various areas of the PC 
World Multimedia Edition LIVE! magazine can usually be attributed to your video card drivers.
 
Information:
The problem you are experiencing is caused by a conflict between ToolBook, Windows, and the 
video card drivers.    If an application performs correctly with one driver but doesn’t with another, 
it is highly likely that the problem is with the driver.    Have you updated the drivers recently?
 
We have learned that ToolBook makes more demands on a display driver than most typical 
Windows programs.    You should contact your video card manufacturer for updated drivers.
 
If your video card has a Turbo Palette, try running PC World Multimedia Edition LIVE! with it 
turned off.
 
Other Possible Reasons for a GPF
- low conventional memory
- TSRs (Terminate and Stay Resident Programs) such as screen savers
- video drivers set to VGA (16 color) instead of SVGA (256 colors)

- using high color mode or high resolutions (for some drivers) - try lowering color mode to 256 
color and resolution back to 640x480 or 800x600



Troubleshooting
 
Memory Errors
 
Summary: 
Memory errors appear when attempting to run the PC World Multimedia Edition LIVE! 
magazine.
 
Information:
If you receive memory errors when running the PC World Multimedia Edition LIVE! magazine, 
you should check the System Resources.    To see how much of your free System Resources 
are available, select About Program Manager from the Program Manager Help menu.    If the 
System Resources are running low, be sure to close all other applications.    Also, instead of 
opening the Tools Palette, you can access all tools from the Tools menu bar to conserve 
memory.
 
It may also be necessary to temporarily disable unnecessary TSR programs such as screen 
savers and third party desktop applications so that conventional memory will increase.    
Conventional memory is the first 640KB of RAM, and TSR (Terminate and Stay Resident) 
programs run in the background and use conventional memory.
 
If all else fails, try running the DOS utility MemMaker to see if you can increase the conventional 
memory.    See your DOS book for complete information.



Troubleshooting

MSVIDEO.DLL Errors
 
Summary:
An MSVIDEO.DLL error appears whenever you try to access PC World Multimedia Edition 
LIVE! files.
 
Information:
You may have an old version of this .dll file hiding in a directory of multiple versions of it on your 
hard drive.    Make sure that the only copy of MSVIDEO.DLL on the system is in your C:
\Windows\System directory.    If you find a copy of this file in the C:\Windows directory, delete it. 
The only copy of it should be in your Windows\System directory.    A new version of this file can 
be obtained by updating the video card drivers.    Please contact the video card driver 
manufacturer for video card driver updates.
 
Or, another program that is loading as a TSR could be using the MSVIDEO.DLL file making it 
unavailable when PC World Multimedia Edition LIVE! tries to access it.    Programs which 
produce sounds and animate icons and task bars such as Wired for Sound Pro by Symantec, 
specifically the FX Module in that program, run in the background as a TSR, thus monopolizing 
the MSVIDEO.DLL file.    To solve the problem, uninstall or disable the program while using PC 
World Multimedia Edition LIVE! 
 
 



Troubleshooting
 
Multitasking with CD Audio
 
Summary:
It is not possible to use PC World Multimedia Edition LIVE! and listen to the CD audio tracks 
simultaneously.
 
Information:
CD-ROM drives can read two types of data:    standard computer data or yellow book, and 
compact disc audio or red book.    Since these two types of data use different standards, the 
drive can read only one mode at a time, making it impossible for you to listen to the CD audio on 
PC World Multimedia Edition LIVE! while moving around the disc.



Troubleshooting

Network Problems
 
Summary:
A "Failed to Initialize Network Book Manager" error appears whenever I try to run PC World 
Multimedia edition LIVE! 
 
Information:
Your computer is probably attached to a network or server.    The Book Manager error indicates 
memory problems.    The solution is to detach from the network, if possible.    Although we don’t 
have a problem with your running the application on a network, the program was written and 
tested to be used on a stand-alone system.
 
 



Troubleshooting

Magazine Doesn’t Run Under OS/2 or Windows NT
 
Summary:
The PC World Multimedia Edition LIVE! magazine doesn’t run correctly under OS/2 or Windows 
NT.
 
Information:
We have many subscribers that use the magazine quite successfully while running OS/2 or 
Windows NT.    However, the magazine was designed to run in a Windows 3.x in a DOS 
environment and Windows 95.
 
It also appears that there may be a conflict with the CD-ROM, audio and video drivers.    As we 
are not experienced with the multimedia aspects of OS/2 and Windows NT, we recommend that 
you contact their technical support staff directly.    They will be able to answer your technical 
questions more efficiently.
 



Troubleshooting

Stack Fault Errors
 
Summary:
A Stack Fault Error is received whenever the PC World Multimedia Edition LIVE! icon is 
accessed.
 
Information:
It sounds like you’re using Windows 3.1 or 3.11.    If so, you should check the CONFIG.SYS file 
for the following    statement:
 
                Stacks=9,256
 
If the statement doesn’t appear in the CONFIG.SYS file, then you need to add it. 
 

Note:    If you’re also getting a General Protection Fault and/or GDI/USER.EXE error, then an 
incompatibility problem with the video card drivers could exist.    In that case, check with your 

video card driver manufacturer to see if you are using the latest drivers.



Troubleshooting
 
Static Sound Card
 
Summary:
The sound card makes static sounds on some of the .WAV files.
 
Information:

Check the DMA setting of your sound card.    It could be set incorrectly.    For instance, if you 
have a Media Vision Pro Audio Spectrum 16 sound card and the current DMA setting is 3, 

change it to 5 and see how that works for you.    See your sound card manual or manufacturer 
for further suggestions.



Troubleshooting
 
Text and Graphics are Cut Off
 
Summary:
The text and graphics do not display correctly on the magazine pages.
 
Information:
If you are having problems with text or graphics being cut off, then you may be using a large 
font video driver.    At this time, it is necessary to use a small font video driver with the magazine 
interface. 



Troubleshooting
 
Undefined Dynalink Errors
 
Summary:
An "Undefined Dynalink Error" appears when the magazine tries to access the QuickTime for 
Windows driver.
 
Information:
This is usually caused by having two or more different versions of QuickTime for Windows or an 
older version of the driver on your system.    The solution is to upgrade to QuickTime for 
Windows driver    version 2.01 or later or to choose the "remove older versions of QuickTime" 
option during its driver installation. 
 
Currently,    PC World Multimedia Edition LIVE! uses version 2.1.1 of QuickTime for Windows.    
A copy of the latest version of QuickTimefor Windows is available on every PC World 
Multimedia Edition LIVE! disc.    To reinstall this driver, just rerun the PC World Multimedia 
Edition LIVE! installation,    or you can install QuickTime manually.



Troubleshooting
 
Video for Windows Driver Will Not Install
 
Summary:
The MCI Microsoft Video for Windows driver will not completely install during the PC World 
Multimedia Edition LIVE! disc installation routine.
 
Information:
Follow the directions to rerun the magazine installation, or you can install Video for Windows 
manually.    When installing this driver, it may be necessary to temporarily disable TSR programs 
such as screen savers or third party desktops. You will need to restart Windows after installing 
this driver.
 
If you are using a high color mode for the video driver (65K colors or above), then try lowering 
the colors to 256 and then reinstall the driver again.    It may also be helpful to temporarily lower 
your resolution to 640x480.    Again, you will need to restart Windows if you have changed the 
video card drive color mode or resolution settings.
 
Lastly, you should make sure that you are using the latest video card drivers that are available 
for your video card.    Please contact your video card manufacturer for driver software updates.
 
 



Troubleshooting
 
Vids: Cvid Decompressor Errors
 
Summary:
When trying to access video from PC World Multimedia Edition LIVE! an error message appears 
that says "video not available...cannot find ‘vids: cvid decompressor."
 
Information:
It’s possible that the QuickTime for Windows and/or the MCI Microsoft Video for Windows 
drivers are corrupted or did not install correctly during installation of the PC World Multimedia 
Edition LIVE! disc.    So, you may need to reinstall these drivers. 
 
To reinstall the drivers, rerun the PC World Multimedia Edition LIVE! disc installation routine, or 
you can install Video for Windows and QuickTime for Windows manually.    You will need to 
restart Windows after installation.
 
Note:    If you are using Windows 95 for your operating system and the above suggestion does 
not work for you, try the following:
 
- Go to your Control Panel and select Add/Remove programs.
- Next, click on the Windows "Setup" tab.
- Scroll down until you see "Multimedia," select it, and click on the "Details" button.
- Make sure that you have "Video Compression" selected.
- If it is not selected, you will be prompted for the proper Windows 95 installation diskette.
    Follow the on-screen instructions.



Troubleshooting
 
Vendor Telephone Numbers
 
If you are looking for updated video or sound drivers, the following vendor telephone numbers 
will assist you.
 
Sound Card Manufacturers:
 
Creative Labs
 

405/742-6622 (Tech)
405/742-6660 (BBS)
 405/742-6633 (Fax)
FTP Site:    ftp.creaf.com

 
MediaVision
 

510/770-9905 (Tech)
510/770-0527 (BBS)
 CompuServe:    GO MediaVision

 
Turtle Beach
 

717/764-5265 (Main)
 717/767-5934 (BBS - 2400 baud)
717/767-0250 (BBS - 9600 baud)

 
 
Video Card Manufacturers:
 
ATI Technologies
 

416/882-2626 (Tech)
416/764-9404 (BBS)
416/882-0546(Fax)
 CompuServe:    GO Atitech
FTP Site:    ftp.atitech.ca

 
Boca Research
 

407/241-8088 (Tech)
407/241-1601 (BBS)
 CompuServe:    GO Boca

 
Diamond Computer 
 

408/325-7100 (Tech)
 408/325-7175 (BBS - 9600 baud & up)



 408/325-7080 (BBS - 2400 baud)
 
Matrox

514/685-2630 (Tech)
514/685-2853 (Fax)
514/685-6008 (BBS)

 
Oak Technology

510/683-0323 (Tech)
510/683-0327 (BBS - 9600 & 14.4 baud)

 
Orchid Technology
 

510/683-0323 (Tech)
510/683-0327 (BBS - 9600 & 14.4 baud)

 
Tseng Labs
 

215/968-0502 (Main)
 215/579-7539 (BBS)
 CompuServe:    GO Tseng

 
Western Digital
 

714/932-4900 (Main)
714/932-6498 (Fax)
 714/753-1234 (BBS up to 14.4 baud)
FTP Site:    ftp.wdc.com
WWW:    www.wdc.com

 

 



Troubleshooting
 
Video Playback / Synchronization
 
Summary:
Videos are not synchronized or do not play smoothly.
 
Information:
Video playback difficulties may result from a combination of the following:    CD-ROM drive 
access and/or throughput, system clock speed, sound card drivers and video card drivers.
 
You can improve playback of QuickTime (.MOV) and Video for Windows (.AVI) movies by 
copying the files to your hard disk.    You can then use the Media Player (MPLAYER.EXE) to 
play the Video for Windows (.AVI) and QuickTime (.MOV) movies.    If you still experience 
playback difficulties from the hard disk, defragmenting the disk may improve performance. 



Troubleshooting
 
Windows 95 Installation
 
Summary:
Installing the PC World Multimedia Edition LIVE! magazine in a Windows 95 environment 
causes video problems.
 
Information:
PC World Multimedia Edition LIVE! has been designed and tested for use with Windows 95 as 
well as a Windows 3.x environment.    If video problems persist,    please check to make sure 
that you are using video drivers that are compatible with Windows 95.    While most video card 
drivers are included on the Windows 95 installation disc,    in some cases it may be necessary to 
contact the video card manufacturer directly for the latest drivers.
 
Additionally, please make sure that the Video Compression option is selected during the 
Windows 95 installation.
 




